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PTF MH01616 HMC V8 R8.5.0 Recovery Media and 

Mandatory PTF MH01617 

This package represents the Recovery image that can be used to upgrade your HMC from HMC 

V8 R8.3.0 or higher to HMC V8 R8.5.0. This package can also be used to install a clean version 

of HMC V8 R8.5.0. You can also reference this package by APAR MB04002 and PTF 

MH01616. The mandatory PTF is APAR MB04003 and PTF MH01617. 

 

Note 1:  During the upgrade to V8 R8.5.0, the local session will display a list of environment 

variables for hmcmanager (last line is "END ENV") for as long as 20 to 40 minutes without a 

screen change.  Do not reboot HMC or power off; wait for the upgrade to complete.  

 

Note 2:  Mandatory fix MH01617 must be installed using the classic GUI or the CLI updhmc 

command. 

 

Package information 

Package name Size Checksum (sha1sum) APAR# PTF# 

 

HMC_Recovery_V8R850_

1.iso 

36068003

84 

fba9f54538bcd097c6b2fc1c0ea51fed78

96c91d 

MB040

02 

MH016

16 

MH01617.iso 21705994 96e388ef0cdfc375acf371e43960bfcafe MB400 MH016
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Mandatory PTF 24 9095cf 03 17 

Splash Panel information (or lshmc -V output) 

After installing the Recovery package 

"version= Version: 8 

  Release: 8.5.0 

  Service Pack: 0 

  HMC Build level 20160422.1 

 ","base_version=V8R8.5.0 

  " 

After installing the Mandatory PTF 

"version= Version: 8 

 Release: 8.5.0 

 Service Pack: 0 

 HMC Build level 201600516.1 

 MH01617: Required fix for HMC V8R8.5.0 (05-16-2016) 

 ","base_version=V8R8.5.0 

"   

Upgrade notes 

 The following Power8 systems are supported by this level of HMC V8 R8.5.0:  

o IBM Power System S812L (8247-21L) 

o IBM Power System S822L (8247-22L) 

o IBM Power System S822 (8284-22A) 

o IBM Power System S814 (8286-41A) 

o IBM Power System S824 (8286-42A) 

o IBM Power System S824L (8247-42L) 

o IBM Power System E870 Server (9119-MME) 

o IBM Power System E850, (8408-E8E) 

o IBM Power System E880 Server (9119-MHE) 

 

 HMC V8 R8.5.0 continues to provide support for Power6 and Power7 based systems. 

 POWER5 servers are not supported from HMC V8. Attempts to manage POWER5 

servers will result in a connection state of Version Mismatch and connection_error_code 

"Connection not allowed 0009-0008-00000000". 

 HMC V8 R8.5.0 supports the following HMC models: 

o Deskside: C08  

o Rack Mount: CR5, CR6, CR7, CR8, CR9, and OE1 

 HMC V8 does not support models CR2, CR3, CR4 and C03, C04, C05, C06, C07. 



 In HMC V8, Classic GUI requires 2GB memory and Enhanced GUI requires 4GB 

memory. If you run over 300 partitions, it is recommended to have 8GB memory. 

 The HMC must be version V8 R8.3.0 or later to be upgraded to HMC V8 R8.5.0. This 

requirement is enforced during installation. 

 When two HMCs manage the same server, both HMCs must be at the same version. 

 If a server is connected to two different versions (i.e., Version 7 and Version 8) of the 

HMC, the higher version HMC will upgrade the partition configuration (profile data of 

the system) to the latest version. After the partition configuration upgrade, lower levels of 

the HMC will not be able to interpret the data correctly. After the server is managed by 

the higher version of the HMC, you must first initialize the server before you use the 

lower version of the HMC. Also, initialize the CEC using lower version of HMC again. 

You can restore a backup that is taken at the older level or re-create the partitions. If the 

server is not initialized with lower version of HMC, one of the following outcomes can 

occur depending on the version of the lower-level HMC: 

o HMC Version 8 Release 8.1.0, 8.2.0, 8.3.0 and 8.4.0 report a connection error of 

Version mismatch with reference code Save Area Version Mismatch if the server 

has been managed by Version 8.5.0. 

o HMC Version 7 Release 7.8.0 and 7.9.0 report a connection error of Version 

mismatch with reference code Save Area Version Mismatch if the server has been 

managed by Version 8. 

o HMC Version 7 Release 7.8.0 reports a connection error of Version mismatch 

with reference code Save Area Version Mismatch if the server has been managed 

by Release 7.9.0 or Version 8. 

o HMC Version 7 Release 7.7.0 and earlier might report a server state of 

Incomplete or Recovery if the server has been managed by a later version and / or 

release. In addition, partition configuration corruption may occur. 

 It is recommended to have all connected VIOS servers on the latest level i.e. VIOS level 

2.2.4.0. To have optimal performance from the Enhanced+ UI, make sure all VIOS are at 

2.2.3.X level or above. 

 All running partitions (AIX Linux and VIOS) should be at RSCT 3.2.0.6 or higher. It is 

recommended to have AIX 6.1 TL9 with SP5 or higher, and AIX 7.1 TL3 with SP5 or 

higher; these SP levels contain RSCT 3.2.0.6. 

 This is the last HMC release that will support the CIM interface on the Open Pegasus port 

5989.  Future releases will only support REST API (port 12443) as the programmatic 

interface for PowerVM management via HMC.  For more information see the forums on 

REST API at 

https://www.ibm.com/developerworks/community/groups/community/powerhmc. 

 

Best Practices 

https://www.ibm.com/developerworks/community/groups/community/powerhmc.


 For partitions enabled with Remote Restart or Simplified Remote Restart, if 

storage/network changes are made using VIOS CLI, without going through the 

HMC,  the user should run the HMC refdev command to refresh the partition 

configuration data stored for remote restart. For more information on Simplified Restart 

go to DeveloperWorks. 

Enhancements and New Functions 
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Enhancements and new function 

New function or enhancement in V8R8.5.0: 

 Enhanced UI enhancements 
o General performance improvements across Enhanced+ UI.  See 

http://ibm.biz/Bd48iu for more info  

o Enhanced+ UI Support for tablet browsers 

 iPad:  Safari and Chrome 

 Android:  Chrome 

 Recommendations 

 Landscape Orientation 

 Minimum resolution 1024 x 768 

 Simplified Remote Restart (SRR) enhancements 
o Allow SRR when HMC has no connection to a server 

o Template support to create SRR-enabled partitions 

o Remote HMC support, i.e. source and destination server managed by different 

HMCs 

o Auto-cleanup on source server 

o LPM support of SRR-enabled partitions between POWER8 and POWER7 

o User specifications (overrides) for Shared Processor Pool and virtual fibre channel 

mapping 

o Increase in concurrent SRRs to 32 

 

 SR-IOV and vNIC enhancements 
o Virtual topology support for SR-IOV and vNIC 

 

 PHYP enhancements  
o Added new feature to support shared processor pool name in PHYP 

 

https://www.ibm.com/developerworks/community/groups/service/html/communityview?communityUuid=0196fd8d-7287-4dff-8526-102b5bcf0df5#fullpageWidgetId=W395818bd593b_487f_a7ec_79c3c27093f8&file=c3bd3dd4-6e63-46a3-966a-a453db50d5c5
https://delivery04.dhe.ibm.com/sar/CMA/HMA/06887/1/MH01616.readme.html#ibm-content
http://ibm.biz/Bd48iu


 Command Line Enhancements 
o Support to add/list/delete static routes 

o Support to list Firewall services 

 HMC Virtual Appliance – enhancements 
o Xen Hypervisor is supported 

 Power Enterprise Pools 
o Support for multiple managing HMCs has been added. Any number of HMCs can 

now manage the servers in a Power enterprise pool, and all servers in the pool no 

longer have to be connected to all of the HMCs or to the master HMC for the 

pool. 

 

 Performance improvements 
o General performance improvements across Enhanced+ UI 

 Display Configuration Utility enhancement 
o A new display configuration menu will be displayed during the HMC startup 

process. User will be able to configure the display device type and resolution 

modes. The new menu will be shown prior to the two existing configuration 

menus used for configuring the locale and keyboard settings. The menu can be 

enabled/disabled using the CLI command chhmc.  

 Per-migration based profile override for inactive partition migration 
o In addition to the existing sever-wide profile override, HMC also allows you to 

specify a per-migration based profile override for migrating an inactive partition. 

This override allows you to specify the current partition configuration or the last 

activated profile to be used to create the migrating partition on the target managed 

system. If you do not specify this override, the existing server-wide override value 

will be used. If you do not specify the server-wide override, the current partition 

configuration will be used. 

 

 Enhanced pedbg command to include additional files such as sftp.log. 

 

Back to top 

 

This package provides the following fixes:  

General fixes 
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 Fixed an issue where the Console Window > Open Terminal Window task fails to open a 

vterm window when launched from the local HMC and the HMC does not have internet 

access.   

 Fixed a problem where Wake On Lan (WOL) failed on model 7042-CR9 even though it 

showed as enabled. 

 Fixed a problem where chhwres -r virtualio command incorrectly fail with error 

HSCL350B when run by a user with a customized task role that was authorized to the 

command. 

 Fixed a problem where Transmit Service Data task for a specific PMH will fail unless the 

target PMH was entitled for the HMC sending the data. 

 Fixed a rare problem that can result in the server having a persistent incomplete state due 

to damage in the server's hardware discovery cache. 

 Fixed an issue where a USB flash device may not be properly detected when 

added/removed during HMC reboots or shutdowns. 

 Fixed an issue where users with a custom resource role may take over a minute longer to 

log in and render GUI. 

 Fixed an error message to correctly display accurate information when a VIOS returns 

VRM_DATA_BASE_FAIL to contact software support. New messages text "HSCLA49C 

The Virtual I/O Server (VIOS) partition returned error VRM_DATA_BASE_FAIL. 

Contact your service representative." 

 Fixed an issue when exporting a SVG diagram (network, storage, vNIC, etc.) as a PDF 

file the complete configuration was not captured. New options are provided to select 

portrait/landscape or Image scaled: Horizontal or Vertical. 

 Fixed an issue where a managed system may go into an Incomplete state after removing 

I/O hardware due to stale data in the hardware discovery cache causing an unhandled 

NullPointerException. 

 Remote Restart Auto Clean up functionality is disabled if PowerVC is Orchestator. 

 Fixed a report of serviceable event E3551081 for a temporary error accessing the Remote 

HMC menu locally on the HMC to be an informational SRC and not call home. 

 Fixed a problem that may result in serviceable events E3690102, E3550996, E3550103, 

and E3550101 being generated during PTF installation. 

 

Command line changes 

 The following commands have been enhanced to support multiple HMCs for Power 

enterprise pools: chcodpool, lscodpool, and mkcodpool. 

 The diagrmc command has been enhanced to check for RMC connection issues between 

HMCs managing a Power enterprise pool. 

 The migrlpar command has been enhanced to provide a profile policy override for 

inactive partition migration operations. The profile policy specifies whether the last 

activated profile for the partition or the current configuration of the partition is to be used 

for the operation. 

 The --requirerr option has been added to the migrlpar command to specify how the 

simplified remote restart capability for migrating partitions is to be handled. 



 New options have been added to the rrstartlpar command to support: 

o simplified partition remote restart operations when the source managed system is 

in No Connection state 

o simplified partition remote restart operations when the destination managed 

system is managed by a different HMC than the source managed system 

o specification of virtual fibre channel adapter mappings and the destination shared 

processor pool for simplified partition remote restart operations 

o configuration of automatic clean up on source managed systems after successful 

remote restart operations 

 A new command, lsrrstartlpar, has been added to display partition remote restart 

information. 

 The --nodetails option has been added to the chlparstate and rrstartlpar commands to 

suppress the display of detail messages. 

 The --admin option has been added to the viosvrcmd command to allow the specified 

command to run as root on the Virtual I/O Server. 

 The --nopreaccept option has been added to the updlic command to prevent the 

previously activated LIC updates from automatically being accepted prior to starting the 

current update. 

 The chhmc and lshmc commands have been enhanced to configure and display network 

static routing information for the HMC. 

 The lshmc command has been enhanced to display the firewall settings for the HMC.  

 The chhmc command has been enhanced to enable/disable the new display configuration 

menu getting shown during the HMC startup process. 

o chhmc –c dispcfg –s enable  

o chhmc -c dispcfg -s disable 
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Known issues and Limitations 

 In NIST mode: 

o RMC code on partition does not support two HMC connections with mixed 

configuration i.e. one HMC running in NIST mode and other one in non-NIST 

mode. Both the HMCs must be in the same mode. 

o HMC uses RSA 2048 type keys to communicate with LPARs. When user 

removes HMC V8 R8.5.0 and connects an older level HMC (i.e HMC V8 R8.2.0 

or before), it will drive NIST mode on the LPARs to be disabled. However the 

LPARs would continue to use RSA 2048 type keys so there would be connection 

establishment issue. To resolve this problem, the LPAR admin should run 

'/usr/sbin/rsct/bin/chsecmode -c none -m rsa512' command on all the 

corresponding LPARs (This command can't be run if LPAR is running any HA 

software like TSA, PowerHA). 

 In non-NIST mode: 

o Following ciphers are not supported although the available cipher list shows them. 
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          TLS_RSA_FIPS_WITH_3DES_EDE_CBC_SHA 

 

          Note this function is fully supported for all other Power systems assuming that the 

appropriate HMC, firmware and PowerVM levels installed.  

 To ensure that the keyboard mapping is working properly for non-English keyboards, the 

codeset for the locale must be set to UTF-8. You can change the codeset by using the 

chhmc command. Example:  

Set the locale to French with UTF-8 codeset for use with French keyboard.  

chhmc -c locale -s modify -l fr_FR.UTF-8 
Set the locale to English with UTF-8 codeset for use with French keyboard. 

chhmc -c locale -s modify -l en_US.UTF-8 
 HMC V8 R8.3.0 to V8 R8.5.0 upgrade script replaces the default templates during the 

upgrade process. Any changes performed on the V8 R8.3.0 default template will be 

overwritten. HMC V8 R8.3.0 to V8 R8.5.0 upgrade script will add the Quick Start 

Templates to the existing Template Library and the user can delete the older Starter 

Templates manually.  

 VIOS installation is supported only through Add VIOS 

 In Enhanced+ UI, Manage VIOS -> Add Logical Host Ethernet Adapter page once user 

has performed add and remove of same HEA port, the HMC does not display the port 

again for addition. As a workaround launch the Add Logical Host Ethernet Adapter page 

again.  

 When a Virtual Ethernet Adapter is created using Enhanced GUI and the next adapter is 

created using Classic GUI, the Slot that is used in Enhanced GUI will be shown as 

Available and set as the default in Classic GUI.  If the user tries to create on that slot an 

error is thrown to the user stating the slot is not available. Circumvention is for the user to 

modify the slot to the next available slot. 

 The Enhanced+ UI login mode does not support disconnected sessions like the Classic UI 

mode. In the Enhanced+ UI mode a session logoff is a logoff and a session disconnect is 

also a logoff. This means that the user cannot reconnect to the Enhanced+ UI session to 

resume the task(s) from where it had left off. Every login via the Enhanced+ mode 

creates a new session. For more details on long running tasks, please refer to the link 

below :  

https://www-

01.ibm.com/support/knowledgecenter/POWER8/p8eh6/p8eh6_loginmode.htm 

 With Power Enterprise Pools, configuration changes made via CLI while the GUI is 

already opened may not be correctly reflected in the GUI even if the refresh button is 

used.  Circumvention is to use the browser'age refresh (F5) to get the latest value.     

 When creating a system plan for a 8282_22A server, the image shown for the 8284_22A 

system incorrectly shows the Expanded View.  The issue has no functional impact. 

 When selecting a different Shared Processor Pool on the Shared Processor Pool panel 

using the enhanced login, the GUI is not refreshing the current values to reflect the newly 

selected pool.  The cirucmvention is  to click "Save" after changing the Shared Processor 

Pool then close and re-launch the enhanced UI. 

 When there is a communication error between the browser and HMC, the user will see a 

default message that states "Click Here" to reload" however the "Click Here" option will 

https://www-01.ibm.com/support/knowledgecenter/POWER8/p8eh6/p8eh6_loginmode.htm
https://www-01.ibm.com/support/knowledgecenter/POWER8/p8eh6/p8eh6_loginmode.htm


cause the UI to hang.   The circumvention is to take note of any unsaved data and reload 

the panel by using the F5 button (refresh the browser) or by logging off and back on. 

 If you perform a Power enterprise pool change operation on a server that is also the 

destination of a running partition migration operation, that Power enterprise pool 

operation will not complete until the partition migration operation completes.  In 

addition, other Power enterprise pool operations, including loading the Power enterprise 

pool GUI, on any of the managing HMCs for the pool may also hang until the partition 

migration completes.  The circumvention is to wait until any active migrations complete 

before making changes to an enterprise pool. 

 The "All Shared Storage Pool Clusters" will not launch successfully if any of the Virtual 

I/O Server managed by the HMC is not configured properly. This includes the Virtual I/O 

Servers that are not Nodes in the Shared Storage Pool Clusters in the HMC. Use ALL 

Systems relational view from which you can view all the partition grouped by System. In 

this view we can easily see the partition been migrated from one system to the other. In 

some rare situations, especially with a Firefox browser, the user may be redirected to a 

second login page after having provided and validated credentials. 

Then, providing the credentials again will fail. If this issue occurs the user should close 

and re-launch the browser to make it work. 

 When concurrently managing the Power enterprise pool, a Power enterprise pool 

administrator may encounter unexpected pool resource assignment data changes due to 

the other concurrent operations done by a Power enterprise pool administrator using the 

GUI.  This is due to the Power enterprise pool GUI caching pool resource assignment 

data that may get stale after other pool operations are done thus overwriting the newer 

pool data with stale data. Note that if pool resource changes are done via the GUI all of 

the resource data will be submitted as the change.   

So for example, a GUI user in the concurrent management scenario who only changes the 

memory resource assignment could overwrite a new processor resource assignment with 

the stale cached processor resource assignment.  And this could happen in the reverse 

case where the user updates only the processor assignment and the stale cached memory 

assignment overwrites the newer memory assignment. 

 From the Enhanced+ HMC, click on HMC management icon in the toolbar, then open the 

Console Management page. Click the Schedule Operation link. The panel which is 

launched is not correct. In order to schedule an operation against the HMC, please use the 

Classic GUI. 

 Enabling or disabling service processor redundancy is only permitted when both Primary 

and Secondary Service Processors are at standby with Service Processor in Position A as 

Primary. The workaround is to set up FSP failover with the following command: 

      chsyscfg -m <server name> -r sys -i "sp_failover_enabled=1" 

 When customers upgrade from V8 R8.1.0 to V8 R8.5.0 (V8 R8.1.0  to V8 R8.3.0 and 

then subsequent updgrade to V8 R8.5.0 without login to UI), any users which existed in 

V8 R8.1.0 will remain but with default user settings. 

 Opening multiple PCM Dashboard windows for the same managed server on the same 

browser or different browser may lead to a communication error on the window that was 

opened first. This is a known issue and the support for multiple PCM Dashboard 

windows is planned for future release.     



 After Templates copy to Templates Library/OS image page, the dashboard navigation is 

disabled. This is a known issue and work around is to open another window from the 

context menu and click on cancel will clear the navigation issue.  

 If the System Templates deploy fails due to the installed VIOS going to Open Firmware 

state, then user can open Virtual Terminal for the VIOS and execute "boot" on the Open 

Firmware prompt to boot the VIOS.   

 If after install no GUI launches, and you only see the CLI localhost login under the 

heading "Base release 7.4. Dev (hmc7_4p) on an x86_64", it's an indication that the 

HMC code is not installed, and only the Operating System has been put on disk. Causes 

could be that the date in UEFI is not the current date/year or DVD media issues.  Set the 

date using the UEFI Setup Utility to be the current date and year, then attempt 

reinstall.  Try different media if the date/year is correct. 

 Virtual terminal (vterm) applet will not launch in the supported version of chrome (42 or 

higher). 

 When installing VIOS using Enhanced+UI mode, the profile name should be the default 

profile.  

 For the Virtual HMC offering, call home for serviceable events with a failing MTMS of 

the HMC itself is disabled.  Those serviceable events should be manually reported to 

IBM software support. 

 Before restoring critical console data, after the 850 Recovery DVD install mandatory 

PTF must be installed, prior to attempting a restore operation. 

 Serviceable event E2FF4304 may be reported during PTF installation and can be ignored.  

 Serviceable event E35F0010 may still be reported on an upgrade from certain levels if the 

fixes at the prior version were not installed before upgrade.  This event indicates that an 

error occurred migrating the HMC user profile properties.  Customized user profile 

settings will be lost and reset to their default.   To recover, edit the user profiles and reset 

the settings.  

 Serviceable Event E2FF1801 may be generated during transmissions for Scheduled 

Software Information tasks and can be ignored.  
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Web browser requirements 

Learn about the requirements your web browser must meet to monitor and control the HMC. 

 

HMC web browser support requires HTML 2.0, JavaScript 1.0, Java™ Virtual Machine (JVM), 

Java Runtime Environment (JRE) Version 8 U71, and cookie support in browsers that will 

connect to the HMC. Contact your support personnel to assist you in determining if your browser 

is configured with a Java Virtual Machine. The web browser must use HTTP 1.1. If you are 

using a proxy server, HTTP 1.1 must be enabled for the proxy connections. Additionally, pop-

ups must be enabled for all HMCs addressed in the browser if running with pop-ups disabled. 

 

The following browsers have been tested:  

Google Chrome 
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HMC Version 8.5.0 supports Google Chrome Version 48. 

Microsoft Internet Explorer  

HMC  V8 R8.5.0 supports Internet Explorer 11.0. 

 If your browser is configured to use an Internet proxy, then local Internet addresses are 

included in the exception list. Consult your network administrator for more information. 

If you still need to use the proxy to get to the Hardware Management Console, enable 

Use HTTP 1.1 through proxy connections under the Advanced tab in your Internet 

Options window. 

 It is recommended to have: 

o Browser security setting in internet zone. If you are running security mode in 

"Local intranet" mode, make sure you do not have any setting to detect intranet 

network; disable Compatibility view. 

o Browser zoom setting to 100%. 

Internet Explorer restriction 
 

When trying to close an Enhanced+ modal popup window in Internet Explorer, a prompt window 

will appear with the question “The webpage you are viewing is trying to close the tab. Do you 

want to close this tab?” You must answer “No” to this question to close only the popup. 

Otherwise, the whole application will be closed.  

Mozilla Firefox 

HMC Version 8.5.0 supports Mozilla Firefox Version 38 Extended Support Release (ESR) and 

Mozilla Firefox Version 45 Extended Support Release (ESR). Ensure that the JavaScript options 

to raise or lower windows and to move or resize existing windows are enabled. To enable these 

options, click the Content tab in the browser's Options dialog, click Advanced next to the Enable 

JavaScript option, and then select the Raise or lower windows option and the Move or resize 

existing windows options. Use these options to easily switch between HMC tasks. For more 

information about the latest Mozilla Firefox ESR levels, see Security Advisories for Firefox 

ESR. 

Browser Cache Clearing 

In Microsoft Internet Explorer  

1. Open the Browser 

2. Select Tools 

3. Select Internet Options 

4. Under Browser History, select Delete 

5. Check "Temporary Internet files and websites files" and "Cookies and website data" 

https://www.mozilla.org/security/known-vulnerabilities/firefoxESR.html
https://www.mozilla.org/security/known-vulnerabilities/firefoxESR.html


6. Click on Delete 

In Mozilla Firefox 

1. In the top-right corner of the browser window click the menu button 

    Choose History, and then Clear Recent History. 

    In time range to clear, select "Everything" 

    In the Details section, select "Cookies" and "Cache" 

    Click on "Clear now" 

2. In the top-right corner of the browser window click the menu button 

    Choose Options > Advanced > Network > 

    In "Offline Web Content and User Data" section click on "Clear Now" 

In Google Chrome 

1. In the top-right corner of the browser window, click the Chrome menu 

    Choose History. 

    Click the button Clear browsing data. A dialog will appear. 

    From the drop-down menu, select "the beginning of time." 

    Check the boxes "Cookies, site, and plug-in data" and "Cache" 

    Click the button Clear browsing data. 

2. Open the following url with the Chrome browser: chrome://appcache-internals/ 

    If there is an entry related to the target hmc, click the corresponding “Remove” link 

Other web browser considerations 

Session cookies need to be enabled in order for ASMI to work when connected to HMC 

remotely. The ASM proxy code saves session information and uses it. 

Internet Explorer 

1. Click Tools > Internet Options. 

2. Click the Privacy tab and select Advanced. 

3. Determine whether Always allow session cookies is checked. 

4. If not checked, select Override automatic cookie handling and Always allow session 

cookies. 

5. For the First-party Cookies and Third-party Cookies, choose block, prompt, or accept. 

Prompt is preferred, in which case you are prompted every time a site tries to write 

cookies. Some sites need to be allowed to write cookies. 

Firefox 

1. Click Tools > Options. 

2. Click the Cookies Tab. 



3. Select Allow sites to set cookies. 

If you want to allow only specific sites, select Exceptions, and add the HMC to allow 

access. 

 

Installation 

Special Install Instructions for mandatory fix MH01617:  This fix must be installed using 

either the classic GUI or the HMC updhmc command; not the enhanced GUI.  See the updhmc 

“man” page (e.g. man updhmc) for further information and examples on using the command. 

Installation instructions for HMC Version 8 upgrades and corrective service can be found at 

these locations: 

Upgrading or restoring HMC Version 8 

 

Instructions and images for upgrading via a remote network install can be found here: 

HMC V8 network installation images and installation instructions 

 

Installation methods for vHMC 

http://www-01.ibm.com/support/knowledgecenter/HW4M4/p8hai/p8hai_installvhmc.htm 

 

After the upgrade, install the mandatory fix using the instructions at: 

Installation methods for HMC Version 8 fixes 

 

Virtual HMC (vHMC) 

The vHMC provides images in 3 additional formats to allow for quick deployment of the vHMC 

on either ESXi, KVM or Xen hypervisors. These images are snapshots of the virtual machine 

and allow for quick deployment of the HMC. 

  

Support for the Xen hypervisor is new for the V8R850 HMC. 

 

A feature of the vHMC is the activation engine which allows you to preconfigure the HMC 

Console by passing configuration information to the HMC at the first boot of the HMC, when 

using these images. 

Please look at the on-line Knowledge Center documentation on using the Activation Engine 

feature.  

http://www-01.ibm.com/support/docview.wss?uid=nas8N1020109
http://www-01.ibm.com/support/docview.wss?uid=nas8N1020109
http://www-01.ibm.com/support/docview.wss?uid=nas8N1020108
http://www-01.ibm.com/support/docview.wss?uid=nas8N1020108
http://www-01.ibm.com/support/knowledgecenter/HW4M4/p8hai/p8hai_installvhmc.htm
http://www-01.ibm.com/support/docview.wss?uid=nas8N1020134
https://www.ibm.com/support/knowledgecenter/HW4L4/p8hai/p8hai_vhmc_ae.htm?lang=en
https://www.ibm.com/support/knowledgecenter/HW4L4/p8hai/p8hai_vhmc_ae.htm?lang=en


 To see if you are running on a virtual HMC use the lshmc -v command. If it displays a 

UVMID field, then you are running in a virtual machine. 

Example: 

lshmc -v 

"vpd=*FC ???????? 

*VC 20.0 

*N2 Wed Aug 26 13:36:06 UTC 2015 

*FC ???????? 

*DS Hardware Management Console 

*TM Vb07-f21 

*SE 6b4b9a5 

*MN IBM 

*PN N/A 

*SZ 1044881408 

*OS Embedded Operating Systems 

*NA 127.0.0.1 

*FC ???????? 

*DS Platform Firmware 

*RM V8R8.5.0.0 

*UVMID b07f:216b:4ce7:b9a5 

" 

 When deploying a virtual HMC, if the mac address is not specified, it will be generated 

by the hypervisor.  Network configuration on the HMC relies on the value of MAC 

addresses. If you re-deploy a new virtual HMC and want to restore critical console data 

previously taken on a virtual HMC, ensure sure you are using the same MAC addresses. 

 When using Activation Engine to setup NTP configuration, you must specify the NTP 

version value. 

 The Activation Engine currently does not provide configuration of DHCP Server on 

virtual HMC. 

Installation Images  

Download of the Power Hardware Management Virtual Appliance (vHMC) install images are 

available at the Entitled Systems Support site (ESS): http://www-

304.ibm.com/servers/eserver/ess/OpenServlet.wss.  You must be entitled to Product ID 5765-

HMV in order to download from the ESS site. 

 

Fixes, mandatory fixes and service packs for the vHMC are common to the Power Hardware 

management console (HMC) and are available at IBM Fix Central. 

 

The splash panel information (lshmc -V output) for the vHMC will be the same as 

for the HMC recovery DVD that is documented in the above description section. 

 

Installation guidance for installing the vHMC into your hypervisor are found in the online 

http://www-304.ibm.com/servers/eserver/ess/OpenServlet.wss
http://www-304.ibm.com/servers/eserver/ess/OpenServlet.wss
https://www-945.ibm.com/support/fixcentral


Knowlege Center. Installation procedures may vary depending on the operating system you use 

and the hypervisor you use.  

 

The mandatory PTF must be installed immediately after installing the virtual machine 

image.  The Mandatory PTF is available on Fix Central.  

Back to top 

 

National Language Support (Supported languages) 

Languages Locales 

English en_US,en_AU,en_BE,en_BE@preeuro,en_CA,en_GB,en_GB@euro,en_HK,en_IE,en_IE@preeuro,en_IN,en_NZ,en_PH,en_PK,en_SG,en_ZA 

Catalan ca_ES, ca_ES@preeuro 

German de_DE, de_DE@preeuro, de_CH, de_AT, de_AT@preeuro, de_LU, de_LU@preeuro 

French fr_FR, fr_FR.UTF-8, fr_CH, fr_CA, fr_BE, fr_BE@preeuro, fr_LU, fr_LU@preeuro 

Italian it_IT, it_IT@preeuro, it_CH 

Spanish es_ES, es_ES@preeuro, es_AR, es_BO, es_CL, es_CO, es_CR, es_DO, es_EC,es_SV, es_GT, es_HN, es_MX, es_NI, es_PA, es_PY,es_PE, es_PR, es_US, es_UY,es_VE 

Brazilian 
Portuguese 

pt_BR 

Portugal 
Portuguese 

pt_PT, pt_PT@preeuro 

Polish pl_PL, pl_PL.UTF-8, pl_PL@euro,pl_PL@preeuro 

Japanese Ja_JP 

Simplified 
Chinese 

zh_CN, zh_SG 

Traditional 
Chinese 

zh_TW, zh_HK 

Korean ko_KR 

Hungarian hu_HU, hu_HU.UTF-8,hu_HU@euro,hu_HU@preeuro 

Dutch nl_NL, nl_NL@preeuro, nl_BE, nl_BE@preeuro 

Russian ru_RU 

Czech cs_CZ, cs_CZ.UTF-8,cs_CZ@euro,cs_CZ@preeuro 

Slovakian sk_SK, sk_SK.UTF-8,sk_SK@euro,sk_SK@preeuro 

Copyright and Trademark Information 

http://www.ibm.com/legal/copytrade.shtml 

Notices 

This information was developed for products and services offered in the US. 

  

https://delivery04.dhe.ibm.com/sar/CMA/HMA/06887/1/%5Cwww.ibm.com%5Csupport%5Cknowledgecenter%5CHW4L4%5Cp8hai%5Cp8hai_installvhmc.htm?lang=en
https://delivery04.dhe.ibm.com/sar/CMA/HMA/06887/1/MH01616.readme.html#ibm-content
http://www.ibm.com/legal/copytrade.shtml_


IBM may not offer the products, services, or features discussed in this document in other 

countries. Consult your local IBM representative for information on the products and services 

currently available in your area. Any reference to an IBM product, program, or service is not 

intended to state or imply that only that IBM product, program, or service may be used. Any 

functionally equivalent product, program, or service that does not infringe any IBM intellectual 

property right may be used instead. However, it is the user's responsibility to evaluate and verify 

the operation of any non-IBM product, program, or service. 

  

IBM may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You 

can send license inquiries, in writing, to: 

  

IBM Director of Licensing 

IBM Corporation 

North Castle Drive, MD-NC119 

Armonk, NY 10504-1785 

US 

  

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to: 

  

Intellectual Property Licensing 

Legal and Intellectual Property Law 

IBM Japan Ltd. 

19-21, Nihonbashi-Hakozakicho, Chuo-ku 

Tokyo 103-8510, Japan 

  



INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 

IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-

INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Some jurisdictions do not allow disclaimer of express or implied warranties in certain 

transactions, therefore, this statement may not apply to you. 

  

This information could include technical inaccuracies or typographical errors. Changes are 

periodically made to the information herein; these changes will be incorporated in new editions 

of the publication. IBM may make improvements and/or changes in the product(s) and/or the 

program(s) described in this publication at any time without notice. 

  

Any references in this information to non-IBM websites are provided for convenience only and 

do not in any manner serve as an endorsement of those websites. The materials at those websites 

are not part of the materials for this IBM product and use of those websites is at your own risk. 

  

IBM may use or distribute any of the information you provide in any way it believes appropriate 

without incurring any obligation to you. 

  

Licensees of this program who wish to have information about it for the purpose of enabling: (i) 

the exchange of information between independently created programs and other programs 

(including this one) and (ii) the mutual use of the information which has been exchanged, should 

contact: 

  

IBM Director of Licensing 

IBM Corporation 

North Castle Drive, MD-NC119 

Armonk, NY 10504-1785 

US 

  



Such information may be available, subject to appropriate terms and conditions, including in 

some cases, payment of a fee. 

  

The licensed program described in this document and all licensed material available for it are 

provided by IBM under terms of the IBM Customer Agreement, IBM International Program 

License Agreement or any equivalent agreement between us. 

  

The performance data and client examples cited are presented for illustrative purposes only. 

Actual performance results may vary depending on specific configurations and operating 

conditions. 

  

Information concerning non-IBM products was obtained from the suppliers of those products, 

their published announcements or other publicly available sources. IBM has not tested those 

products and cannot confirm the accuracy of performance, compatibility or any other claims 

related to non-IBM products. Questions on the capabilities of non-IBM products should be 

addressed to the suppliers of those products. 

  

Statements regarding IBM's future direction or intent are subject to change or withdrawal 

without notice, and represent goals and objectives only. 

  

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change 

without notice. Dealer prices may vary. 

  

This information is for planning purposes only. The information herein is subject to change 

before the products described become available. 

  

This information contains examples of data and reports used in daily business operations. To 

illustrate them as completely as possible, the examples include the names of individuals, 

companies, brands, and products. All of these names are fictitious and any similarity to actual 

people or business enterprises is entirely coincidental. 

  



COPYRIGHT LICENSE: 

  

This information contains sample application programs in source language, which illustrate 

programming techniques on various operating platforms. You may copy, modify, and distribute 

these sample programs in any form without payment to IBM, for the purposes of developing, 

using, marketing or distributing application programs conforming to the application 

programming interface for the operating platform for which the sample programs are written. 

These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot 

guarantee or imply reliability, serviceability, or function of these programs. The sample 

programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any 

damages arising out of your use of the sample programs. 

  

Each copy or any portion of these sample programs or any derivative work must include a 

copyright notice as follows: 

  

© (your company name) (year). 

Portions of this code are derived from IBM Corp. Sample Programs. 

© Copyright IBM Corp. _enter the year or years_. 

  

If you are viewing this information in softcopy, the photographs and color illustrations may not 

appear. 

Trademarks 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International 

Business Machines Corp., registered in many jurisdictions worldwide. Other product and service 

names might be trademarks of IBM or other companies. A current list of IBM trademarks is 

available on the web at Copyright and trademark information at 

www.ibm.com/legal/copytrade.shtml. 

  

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel 

Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel 

Corporation or its subsidiaries in the United States and other countries. 

http://www.ibm.com/legal/copytrade.shtml
http://www.ibm.com/legal/copytrade.shtml


  

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

  

Microsoft is a trademarks of Microsoft Corporation in the United States, other countries, or both. 

  

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle 

and/or its affiliates. 

 


